D5.5 Workflow Development Tools - Final Version

Version 2.0
30 June 2019
Final

Public Distribution

University of York

Project Partners: Athens University of Economics & Business, Bitergia, Castalia Solutions, Centrum Wiskunde & Informatica, Eclipse Foundation Europe, Edge Hill University, FrontEndART, OW2, SOFTEAM, The Open Group, University of L’Aquila, University of York, Unparallel Innovation

Every effort has been made to ensure that all statements and information contained herein are accurate, however the CROSSMINER Project Partners accept no liability for any error or omission in the same.

© 2019 Copyright in this document remains vested in the CROSSMINER Project Partners.
## Project Partner Contact Information

<table>
<thead>
<tr>
<th>Athens University of Economics &amp; Business</th>
<th>Bitergia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diomidis Spinellis</td>
<td>José Manrique Lopez de la Fuente</td>
</tr>
<tr>
<td>Patision 76</td>
<td>Calle Navarra 5, 4D</td>
</tr>
<tr>
<td>104-34 Athens</td>
<td>28921 Alcorcón Madrid</td>
</tr>
<tr>
<td>Greece</td>
<td>Spain</td>
</tr>
<tr>
<td>Tel: +30 210 820 3621</td>
<td>Tel: +34 6 999 279 58</td>
</tr>
<tr>
<td>E-mail: <a href="mailto:dds@aueb.gr">dds@aueb.gr</a></td>
<td>E-mail: <a href="mailto:jsmanjrie@bitergia.com">jsmanjrie@bitergia.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Castalia Solutions</th>
<th>Centrum Wiskunde &amp; Informatica</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boris Baldassari</td>
<td>Jurgen J. Vinju</td>
</tr>
<tr>
<td>10 Rue de Penthièvre</td>
<td>Science Park 123</td>
</tr>
<tr>
<td>75008 Paris</td>
<td>1098 XG Amsterdam</td>
</tr>
<tr>
<td>France</td>
<td>Netherlands</td>
</tr>
<tr>
<td>Tel: +33 6 48 03 82 89</td>
<td>Tel: +31 20 592 4102</td>
</tr>
<tr>
<td>E-mail: <a href="mailto:boris.baldassari@castalia.solutions">boris.baldassari@castalia.solutions</a></td>
<td>E-mail: <a href="mailto:jurgen.vinju@cwi.nl">jurgen.vinju@cwi.nl</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Eclipse Foundation Europe</th>
<th>Edge Hill University</th>
</tr>
</thead>
<tbody>
<tr>
<td>Philippe Krief</td>
<td>Yannis Korkontzelos</td>
</tr>
<tr>
<td>Annastrasse 46</td>
<td>St Helens Road</td>
</tr>
<tr>
<td>64673 Zwingenberg</td>
<td>Ormskirk L39 4QP</td>
</tr>
<tr>
<td>Germany</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>Tel: +33 62 101 0681</td>
<td>Tel: +44 1695 654393</td>
</tr>
<tr>
<td>E-mail: <a href="mailto:philippe.krief@eclipse.org">philippe.krief@eclipse.org</a></td>
<td>E-mail: <a href="mailto:yannis.korkontzelos@edgehill.ac.uk">yannis.korkontzelos@edgehill.ac.uk</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FrontEndART</th>
<th>OW2 Consortium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rudolf Ferenc</td>
<td>Cedric Thomas</td>
</tr>
<tr>
<td>Zászló u. 3 I/5</td>
<td>114 Boulevard Haussmann</td>
</tr>
<tr>
<td>H-6722 Szeged</td>
<td>75008 Paris</td>
</tr>
<tr>
<td>Hungary</td>
<td>France</td>
</tr>
<tr>
<td>Tel: +36 62 319 372</td>
<td>Tel: +33 6 45 81 62 02</td>
</tr>
<tr>
<td>E-mail: <a href="mailto:ferenc@frontendart.com">ferenc@frontendart.com</a></td>
<td>E-mail: <a href="mailto:cedric.thomas@ow2.org">cedric.thomas@ow2.org</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SOFTEAM</th>
<th>The Open Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alessandra Bagnato</td>
<td>Scott Hansen</td>
</tr>
<tr>
<td>21 Avenue Victor Hugo</td>
<td>Rond Point Schuman 6, 5th Floor</td>
</tr>
<tr>
<td>75016 Paris</td>
<td>1040 Brussels</td>
</tr>
<tr>
<td>France</td>
<td>Belgium</td>
</tr>
<tr>
<td>Tel: +33 1 30 12 16 60</td>
<td>Tel: +32 2 675 1136</td>
</tr>
<tr>
<td>E-mail: <a href="mailto:alessandra.bagnato@softeam.fr">alessandra.bagnato@softeam.fr</a></td>
<td>E-mail: <a href="mailto:s.hansen@opengroup.org">s.hansen@opengroup.org</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>University of L’Aquila</th>
<th>University of York</th>
</tr>
</thead>
<tbody>
<tr>
<td>Davide Di Ruscio</td>
<td>Dimitris Kolovos</td>
</tr>
<tr>
<td>Piazza Vincenzo Rivera 1</td>
<td>Deramore Lane</td>
</tr>
<tr>
<td>67100 L’Aquila</td>
<td>York YO10 5GH</td>
</tr>
<tr>
<td>Italy</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>Tel: +39 0862 433735</td>
<td>Tel: +44 1904 325167</td>
</tr>
<tr>
<td>E-mail: <a href="mailto:davide.diruscio@univaq.it">davide.diruscio@univaq.it</a></td>
<td>E-mail: <a href="mailto:dimitris.kolovos@york.ac.uk">dimitris.kolovos@york.ac.uk</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unparallel Innovation</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Bruno Almeida</td>
<td></td>
</tr>
<tr>
<td>Rua das Lendas Algarvias, Lote 123</td>
<td></td>
</tr>
<tr>
<td>8500-794 Portimão</td>
<td></td>
</tr>
<tr>
<td>Portugal</td>
<td></td>
</tr>
<tr>
<td>Tel: +351 282 485052</td>
<td></td>
</tr>
<tr>
<td>E-mail: <a href="mailto:bruno.almeida@unparallel.pt">bruno.almeida@unparallel.pt</a></td>
<td></td>
</tr>
</tbody>
</table>
## DOCUMENT CONTROL

<table>
<thead>
<tr>
<th>Version</th>
<th>Status</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Full draft version</td>
<td>14 June 2019</td>
</tr>
<tr>
<td>1.2</td>
<td>Further updates and final for internal review</td>
<td>24 June 2019</td>
</tr>
<tr>
<td>2.0</td>
<td>Final Version</td>
<td>30 June 2019</td>
</tr>
</tbody>
</table>
# Table of Contents

1. Introduction ...................................................................................................................... 1  
   1.1 Motivation ....................................................................................................................... 1  
   1.2 Outline ............................................................................................................................ 2  

2. Crossflow Workflow Language .......................................................................................... 3  
   2.1 Running Example ............................................................................................................ 4  
   2.2 Code Generation ............................................................................................................ 4  

3. Graphical Workflow Modeling ............................................................................................ 7  
   3.1 Background ..................................................................................................................... 7  
   3.2 Crossflow Graphical Model Editor (EuGENia-based) ..................................................... 7  
       3.2.1 Editor Updates ........................................................................................................... 8  

4. Textual Workflow Modeling ................................................................................................ 11  
   4.1 Background ................................................................................................................... 11  
   4.2 Crossflow Textual Model Editor (Xtext-based) ............................................................. 12  
       4.2.1 Editor Updates ......................................................................................................... 15  
   4.3 Crossflow XML-based Model Editing (Flexmi) ............................................................ 16  

5. Workflow Deployment, Execution, and Monitoring ............................................................. 17  
   5.1 Crossflow Model Deployment and Execution (Eclipse) ............................................... 17  
   5.2 Crossflow Model Deployment, Execution, Monitoring, and Management (Web-based) 18  
   5.3 Crossflow Worker Execution (CLI) ................................................................................ 26  

6. Installation Guides ............................................................................................................. 28  
   6.1 Crossflow Graphical Editor Installation and Launch ................................................... 28  
   6.2 Crossflow Textual Editor Installation and Launch ....................................................... 28  
   6.3 Crossflow Web Application Installation and Launch .................................................. 29  

7. Conclusion and Future Work .............................................................................................. 31  

Table on final status of use-case partner requirements for WP5 ........................................... 32  
Table on final status of technology requirements for WP5 .................................................. 33  

REFERENCES ......................................................................................................................... 34  

Appendix A: Crossflow Graphical Modeling Language Definition (crossflow.emf) ............. 35  
Appendix B: Crossflow Textual Workflow Modeling Language Definition (Crossflow.xtext) 37
EXECUTIVE SUMMARY

Work package 5 (WP5) aims at creating a framework for supporting the development of high-performance declarative open-source project analysis workflows. This is underpinned by Crossflow—a domain-specific language capable of expressing open-source project analysis workflows in a high level of abstraction. Creation and execution of Crossflow workflows is aided by an Eclipse-based graphical editor and a browser-based interface providing feedback during and after the execution of the workflow, respectively. Workflows are executed through a scalable execution engine, capable of both parallel and distributed execution that is running against code generated using appropriate model transformation languages to executable code.

This document expands upon D5.3 by providing details into the current implementation of Crossflow by means of an Eclipse-based graphical model editor as well as by presenting new components that include a browser-based workflow deployment, monitoring, and execution-management interface. First, it presents an exemplary use case showcasing the creation of a Crossflow workflow model, the generation of base classes from such a model, as well as the specification of fine-grained behaviour through implementations extending generated code. Secondly, it presents packaging and deployment of Crossflow workflows as well as their monitoring and execution-management during runtime.
1. INTRODUCTION

This document will present the development tools of the workflow component of CROSSMINER. Workflows allow for the definition of bespoke analysis algorithms in a high-level domain-specific language and require the creation of appropriate tools to create, manipulate, generate and monitor them and their execution.

Figure 1 depicts the integration of Crossflow in the Crossminer architecture. On one hand, workflow specifications, i.e. Crossflow models created by the employing workflow development tools described in Sections 3-4 of this document, can be executed by metric providers by instantiating the Crossflow Java API. On the other hand, Crossflow workflow tasks can retrieve data from the Crossminer knowledge base REST API (cf. Section 9.4 in D6.5). In more detail, data from the knowledge base can be retrieved within the context of a Crossflow workflow by submission of HTTP GET/POST requests that are coded into workflow tasks and triggered during their workflow execution (cf. Figure 36 in D6.5).

1.1 MOTIVATION

Two important factors when measuring the effectiveness of a software process or product are the level of abstraction and the level of reusability. Important aspects in this regard include increasing...
the developer's productivity, decreasing the cost of software construction while preserving the desired quality and improving the reusability and maintainability of software.

Model Driven Development (MDD), is an approach to software development elevating models to first-class citizens of the process (Mohagheghi, Fernandez, Martell, Fritzsche, & Gilani, 2009). As such, it is focused on the creation of semantically-rich models encapsulating the problem and/or solution domains, while leaving the execution domain to model-based code generators.

Such models can be based on a graphical or textual representation (or a mixture of both) and be supported by graphical or textual design tools. These tools can either be generic and bound to a high-level abstract domain (such as object graphs), hence requiring more effort to describe domain-specific concepts or are bound to the domain and cannot be used for any other purpose. As such, it is both important to choose the appropriate level of abstraction and the type of representation for the domain in question.

1.2 OUTLINE

Modeling language editors are commonly split into three categories: graphical, textual, and hybrid; in D5.3 we presented an overview of those categories and their core differences. In this deliverable we briefly describe the selection of tools and frameworks upon which Crossflow editor implementations are built. Moreover, we present the current state of the Crossflow graphical and textual editor implementation in detail and alongside a running example. Next, we present the Crossflow web application enabling deployment, monitoring, and management of workflow execution in web browser environments.
2. **CROSSFLOW WORKFLOW LANGUAGE**

This section provides a short overview of the Crossflow language (Kolovos, Neubauer, Barmpis, Matragkas, & Paige, 2019) by describing its concepts and thus updating earlier deliverables such as D5.1. The Crossflow language is defined by the Crossflow Ecore metamodel (cf. simplified version in Figure 2) that is referenced by both graphical and textual language implementation of Crossflow presented in Section 3.2 and 4.2, respectively, as well as used by the Crossflow code generator to produce strongly-typed scaffolding Java code from workflow models.

![Figure 2: Simplified version of the Crossflow language metamodel (crossflow.ecore).](image)

**Workflow.** In detail, instances of a Crossflow Workflow may contain types, streams, tasks, and languages.

**Type.** Instances of Type represent data types and may specify multiplicity (isMany attribute), existing (or intended) implementations through the value of the impl attribute as well as instances of Field detailed by a name, multiplicity (isMany attribute), and type.

**Stream.** Instances of Stream either represent queues or topics in a workflow model. Streams manifest either as instances of Queue or Topic and receive input from tasks as well as produce output for tasks. Queues and topics are following the point-to-point and publish-subscribe subscription model, respectively.

**Task.** Instances of Task are defined by name, execution restriction to only allow the master node to execute them (masterOnly attribute), and output multiplicity (multipleOutputs attribute). Moreover, tasks may manifest as instances of Source or Sink. Sources and sinks produce input and output for their containing workflow, respectively.

**Language.** Instances of Language are defined by name, package, generated source code output directory (outputFolder attribute), and generated base source code output directory (genOutputFolder attribute). Moreover, languages may own parameters. Instance of Parameter are defined by name and value to represent additional information required by a particular language. For example, the Python language requires the specification of a parameter named module for modularization, i.e. splitting programs into several programs to enable reuse and ease maintenance.
2.1 Running Example

This subsection provides a brief introduction of the running example appearing throughout the remaining sections of the document.

In summary, the initial activity in the running example, i.e. TechnologySource in Figure 3, entails reading tuples consisting of keyword and file extension from a comma separated file (CSV). Next, the CodeSearcher activity involves looking for instances of files from specific modeling technologies on GitHub, i.e. by using their file extensions and a keyword contained in the file as the matching metric. The repositories containing such files are then cloned locally and various analysis steps are performed to calculate the number of repositories, files and authors for each such technology (cf. RepositorySearcher). Finally, this analysis data is aggregated and output to console (cf. RepositoryResultSink).

More specifically, the first time the example workflow is executed in a distributed setup, different worker nodes will end up with different cloned Git repositories as a result of the execution of their repository search tasks (cf. RepositorySearchDispatcher). The next time the workflow is executed (e.g. after a bug fix or after adding more technologies to the input CSV file), repository search jobs, i.e. executing queries to the GitHub API, are routed to nodes that already have clones of relevant repositories from the previous execution (if available). Thus, unnecessary cloning of the same repositories in different nodes as required by subsequent repository analysis jobs, i.e. requiring access to repository clones, is prevented.

Figure 3: Crossflow Running Example Activity Diagram.

2.2 Code Generation

The capability of generating base classes and executables from models created by either one of the Crossflow editors (cf. 3.2 and 4.2) has been made available to the Eclipse environment through context menu entries. Note that this capability requires the installation of Crossflow as outlined in Section 60. Moreover, make sure that Crossflow executables have been created beforehand.

Crossflow models, i.e. files with the extension crossflow_diagram and crossflow_model, can be employed for base class code generation by right-click and selection of “Crossflow” followed by “Generate CROSSFLOW Base Classes” in the Package Explorer view (cf. Figure 4). In detail, this will generate base classes and skeletons of implementations classes in the location defined by the property “Gen Output Folder” and “Output Folder” of Language instances, respectively (cf. Figure 5). The keywords outputFolder and genOutputFolder of Language instances in textual Crossflow models serve the equivalent purpose (cf. Figure 6).
Additionally, a folder named “experiment” is created containing workflow input and output data directories, a web browser-based representation of the Crossflow model for the web browser (abstract.graph), and a configuration file for the Crossflow model deployment, execution, monitoring, and management web application (experiment.xml).

Finally, the generation of executables of the selected Crossflow model as well as their assembly into a ready-to-deploy ZIP archive is accomplished by right-clicking on the Crossflow model in the Package Explorer view and selecting “Crossflow” followed by “Generate Deployment Artifacts”. Figure 7 shows the running example in the Package Explorer in its ready-to-deploy state.
Figure 7: Running example project ready-to-deploy state in Package Explorer view.
3. **GRAPHICAL WORKFLOW MODELING**

This section provides background on graphical editors and in particular EuGENia\(^1\) (Kolovos, García-Domínguez, Rose, & Paige, 2017) and GMF, i.e. the open-source (modeling) language graphical editor creation tool chosen to implement the Crossflow graphical editor. Crossflow is the domain-specific language created for constructing and editing workflows in CROSSMINER and is described in D5.2, Section 2.

### 3.1 BACKGROUND

Graphical editors focus on the use of shapes and images to provide a high-level representation of the domain model. Such editors often provide common graphics-related functionalities like inserting, deleting, moving and resizing graphical elements, which are directly linked to the domain model elements themselves; as such, any domain-level changes made in these graphical elements (such as the addition of a reference to another element) will be mirrored in the relevant domain model elements.

This type of editor is well suited for rapid creation/prototyping of models from small- to medium-sized languages with the use of drag-and-drop or copy-paste techniques. When the language starts becoming sufficiently large, graphical editors may end up overly complex to use, as finding appropriate elements or connections in the UI may start becoming laborious. Similarly, when the model itself is sufficiently large, navigating such a visual space may end up taking substantial amounts of time and effort. Techniques like views and filters can alleviate some of these concerns but the core issue of managing large models in a graphical environment is a complex one, nevertheless.

**EuGENia.** EuGENia (Kolovos, García-Domínguez, Rose, & Paige, 2017) is a graphical editor generation language as part of the Epsilon\(^2\) modeling suite. It is described as a front-end to GMF, aimed at speeding up the process of creating GMF-based graphical editors. Simple editors can be generated with the addition of a small number of annotations to the language (metamodel) denoting which elements are to be represented visually in the diagram (and which shape they will be), which references in the language (from one element to another) are to be visible, which element represents the diagram itself, etc. Further enhancements to the editor can be achieved in multiple ways, such as by editing the generated Java code of the editor and adding any custom logic regarding the representation of any diagram elements and their interactions, as well as any additional UI elements that may be useful for the current domain. An alternative is to create a polishing transformation (written in the Epsilon Object Language\(^3\)) that has access to and can manipulate both the language model and the graphical model that is used to create the generated editor.

### 3.2 CROSSFLOW GRAPHICAL MODEL EDITOR (EuGENia-BASED)

In order to use EuGENia to generate a graphical editor for Crossflow, the Crossflow language had to be augmented with relevant annotations denoting the various visual semantics of each element. Details on concepts available in the Crossflow language are described in Section 2. Moreover,

---

\(^1\) [https://www.eclipse.org/epsilon/doc/EuGENia/](https://www.eclipse.org/epsilon/doc/EuGENia/)

\(^2\) [https://www.eclipse.org/epsilon/](https://www.eclipse.org/epsilon/)

\(^3\) [https://www.eclipse.org/epsilon/doc/eol/](https://www.eclipse.org/epsilon/doc/eol/)
Appendix A: Crossflow Graphical Modeling Language Definition (crossflow.emf) provides a complete copy of the Crossflow graphical workflow modelling language definition, i.e. by means of crossflow.emf, that is current as by the time of the submission of this document. It shows a textual representation of the enhanced language, including the aforementioned annotations.

3.2.1 Editor Updates

In comparison to the previous version of the editor (cf. Figure 8), the current version of the editor (cf. Figure 9) reflects the following adjustments:

- The graphical element of queues has been customized by replacing the circle shape with the shape of a cylinder.
- The graphical element of sources and sinks has been customized by replacing the shape of rounded rectangles with trapezoids.
- The rectangularly-shaped concept of Language and fields to select the language for instances of tasks, i.e. including Source and Sink, i.e. specific forms of Task, has been introduced to conform to the latest version of the Crossflow metamodel.

Figure 8: Running example workflow visualized in the previous version of the Crossflow graphical model editor (cf. D5.3).
The Crossflow Diagram Editing editor enables populating Crossflow graphical models, i.e. files with the extension `.crossflow_diagram`, with elements of the Crossflow language by the use of the editor’s palette panel and properties view. For example, the task `RepositorySearcher`
of type `CommitmentTask` uses a configuration of type `TechnologyCollection` and produces multiple outputs to the `RepositoryResults` queue (cf. Figure 10).

![Crossflow Graphical Editor palette panel and properties view usage example.](image-url)
4. **TEXTUAL WORKFLOW MODELING**

This section provides background on textual editors and in particular Xtext\(^4\) (Eysholdt & Behrens, 2010), i.e. the open-source (modeling) language textual editor creation tool chosen to implement the Crossflow textual editor, and Flexmi\(^5\) (Kolovos, Matragkas, & Garcia-Dominguez, Towards Flexible Parsing of Structured Textual Model Representations, 2016). Crossflow is the domain-specific language created for constructing and editing workflows in CROSSMINER and is described in D5.3, Section 3.

4.1 **BACKGROUND**

Textual editors focus on using structured text for managing domain models. This text is often a simplified view of the domain elements themselves, often augmented with small textual or graphical queues to aid the understanding of the structure. Such editors often offer a tree-based view of the model, whereby each domain element is displayed as a separate line of text, containing any of its features nested inside it; other views can include table views, commonly used for editing the features of domain elements.

This type of editor can easily represent the containment structure of a model and offers an alternative development approach for those more adept at creating text-based documents. Whilst textual editors can show the structure of arbitrarily large models, managing such models can still remain challenging as one may need to find and manipulate specific elements in the model that they may not be able to uniquely identify without navigating a large portion of the model itself.

**Xtext.** To support the development of textual Domain-Specific Modeling Languages (DSMLs) (Kelly & Tolvanen, 2008), frameworks, such as Xtext (Eysholdt & Behrens, 2010), emerged, enabling language designers to ease and speed-up language development by leveraging advances in editor technology of mainstream IDEs. Such frameworks automate, for instance, the creation of language specific parsers, serializers, and editors providing basic syntax highlighting, content-assist, folding, jump-to-declaration, and reverse reference lookup across multiple files.

The kind of language created by employing Xtext, which relies on the EMF, can range from small DSMLs to fully-blown General Purpose Languages (GPL). This also includes textual configurations files or human-readable requirement documents. The motivation of Xtext is to automate the generation of basic tooling support for language specifications and thus increase readability, writability, and understandability of documents written in those languages.

Starting with a grammar definition, Xtext generates a parser, serializer and a basic editor implementation for the specified language. Moreover, generated artifacts can be adapted via dependency injection and the use of the Xtext API. Thus, generated artifacts can include customized implementations, such as for validation and linking/scoping.

**Flexmi.** Flexmi is a flexible algorithm for parsing well-formed XML documents into Ecore metamodel-conforming in-memory models. The parser developed for Flexmi performs a depth-first traversal of the elements in the XML document, expects to find a nsuri processing instruction, i.e. declaring a unique namespace identifier, and employs a stack to keep track of its position during document parsing. The Flexmi implementation also includes a renderer that is accessible as an Eclipse view named “Flexmi Renderer”.

---

\(^4\) http://www.xtext.org

\(^5\) https://www.eclipse.org/epsilon/doc/articles/flexmi/
4.2 **CROSSFLOW TEXTUAL MODEL EDITOR (XTEXT-BASED)**

In this section we present the Crossflow textual DSML, i.e. conforming to the structural components of the Crossflow language as defined by the Crossflow metamodel (cf. Figure 2).

Appendix A: Crossflow Graphical Modeling Language Definition (crossflow.emf) provides a complete copy of the language grammar that is current as by the time of the submission of this document.

The Crossflow Editor editor enables populating Crossflow textual models, i.e. files with the extension `.crossflow_model`, with elements of the Crossflow language either by inserting textual tokens or by using of the editor’s content assist feature accessible through the keyboard shortcut CTRL + Space followed by the selection of an element offered by the displayed list of viable textual tokens to be inserted at the current position of the cursor. For example, selecting CodeSearcher as viable value for the Repositories queue’s outputOf attribute (cf. Figure 11).

![Figure 11: Crossflow Textual Editor content assist usage example.](image)

Figure 11: Crossflow Textual Editor content assist usage example.

Moreover, the editor offers validation and quick fix features. The former is triggered as a result of any change performed to the textual model. The latter is accessible by clicking on the light bulb error indicator and selecting an appropriate solution (cf. Figure 12).

![Figure 12: Crossflow Textual Editor validation and quick fix usage example.](image)

Figure 12: Crossflow Textual Editor validation and quick fix usage example.
The complete runtime example’s Crossflow textual model equivalent to the Crossflow graphical model (cf. Figure 9) is depicted in Figure 13 (types and languages), Figure 14 (tasks), and Figure 15 (streams).
Figure 13: Running example workflow types and languages visualized in the Crossflow textual model editor.
4.2.1 Editor Updates

Similarly to the updates made in the graphical editor (cf. Section 3.2.1), the textual editor has been adapted to conform to the latest version of the Crossflow metamodel (cf. Figure 2). For example, grammar rules for representing the concept of Language and Field have been introduced.
### 4.3 CROSSFLOW XML-BASED MODEL EDITING (FLEXMI)

In this section we present the result of the running example modelled using the XML-based Flexmi editor (cf. Figure 16) as well as its rendered version in the Flexmi Renderer (cf. Figure 17).

```xml
<workflow name="TechnologyAnalysis">
  <!-- TASKS -->
  <csrs:source name="TechnologySource" masterOnly="true" output="Technologies" fileName="input.csv" languages="Java"/>
  <csrs:task name="CodeSearcher" multipleOutputs="true" input="Technologies" output="Repositories" languages="Java"/>
  <csrs:task name="RepositorySearchDispatcher" multipleOutputs="true" input="Repositories" output="RepositorySearches" languages="Java"/>
  <commit:{version} task name="RepositorySearchDispatcher" multipleOutputs="true" input="RepositorySearches" output="RepositoryResults" languages="Java">
    <commitAfter="1" configurations="TechnologyCollection"/>
  </commit:
  <csrs:link name="RepositoryResultSink" masterOnly="true" fileName="output.csv" input="RepositoryResults" languages="Java"/>

  <!-- QUEUES -->
  <queue name="Technologies" type="Technology"/>
  <queue name="Repositories" type="Repository"/>
  <queue name="RepositorySearches" type="RepositorySearch"/>
  <queue name="RepositoryResults" type="AnalysisResult"/>

  <!-- LANGUAGES (Java is set by default, can be neglected, and appears here for integrity purposes only) -->
  <language name="Java" package="org.eclipse.scava.crossflow.examples.techanalysis.flexmi" outputFolder="src genOutputFolder="src-gen"/>

  <!-- TYPES -->
  <type name="Technology">
    <field name="fileExt" type="String"/>
    <field name="techKey" type="String"/>
    <type name="Repository" isMany="true" extending="Technology">
      <field name="url" type="String"/>
    </type>
    <type name="AnalysisResult" isMany="true" extending="Technology">
      <field name="fileCount" type="Int"/>
      <field name="authorCount" type="Int"/>
      <field name="technology" type="String"/>
    </type>
    <type name="TechnologyCollection"/>
  </type>
  <type name="Technology" many="true"/>
</workflow>
```

**Figure 16:** Running example workflow visualized in the Flexmi Editor.

![Diagram of the Flexmi Editor](image)

**Figure 17:** Running example workflow visualized in the Flexmi Renderer.

![Diagram of the Flexmi Renderer](image)
5. **Workflow Deployment, Execution, and Monitoring**

This section presents the implementation of for the deployment, execution, and monitoring of workflow models created by the Crossflow Graphical Model Editor and Crossflow Textual Model Editor presented in 3.2 and 4.2, respectively. Finally, we present the Crossflow Command Line Interface (CLI) in X.

5.1 **Crossflow Model Deployment and Execution (Eclipse)**

The capability of deploying and executing models that have been created by either one of the Crossflow editors (cf. Sections 3.2 and 4.2) has been made available to the Eclipse environment through context menu entries. Note that this capability requires the installation of Crossflow as outlined in Section 6. Moreover, make sure that Crossflow executables have been created beforehand. Crossflow models, i.e. files with the extension `crossflow_diagram` and `crossflow_model`, can be deployed by right-click and selection of “Crossflow” followed by “Deploy Artifacts” in the Package Explorer view (cf. Figure 18).

![Figure 18: Running example workflow upload in Crossflow context menu.](image)

The result of this procedure is visible by pointing a web browser to the start page of the Crossflow web application (cf. Figure 19).

![Figure 19: Running example workflow upload completed in Crossflow web application.](image)
Further, to trigger the execution of the selected Crossflow model right after it has been deployed, right-click the Crossflow model in the Package Explorer view and select “Crossflow” followed by “Deploy Artifacts and Run (new browser window)”. Consequently, a new instance of the operating system’s default browser will open and navigate to Crossflow web application start page and display the uploaded workflow as “running”, i.e. instead of “stopped”, after a delay of approximately three seconds, i.e. allowing the web server runtime to load uploaded resources.

5.2 CROSSFLOW MODEL DEPLOYMENT, EXECUTION, MONITORING, AND MANAGEMENT (WEB-BASED)

This subsection describes steps involved during deployment, execution, monitoring, and management of Crossflow models by the use of the Crossflow web application.

Configuration. Workflows that are deployed within the Crossflow web application are configured by means of an XML-based experiment configuration file. Figure 20 depicts the generated experiment configuration of the running example adapted in line two, seven, and thirteen by replacing the auto-generated title, summary, and description stub of the experiment, respectively. Line three specifies the root class of the running example, i.e. extending org.eclipse.scava.crossflow.runtime.Workflow, owning the workflow’s streams and tasks as well as behaviour to launch master and worker instances. Line four defines the name and path to the running example workflow packaged as a Java ARchive (JAR). Lines five and six specify the experiment’s input and output directory, respectively. Lines ten and eleven specify the experiment’s input and output files for workflow Source and Sink and appear as “Input” and “Output” tab on the experiment’s dedicated page in the Crossflow web application, respectively. Line eight defines the target web server running an instance of the Crossflow web application by means of its IP address or DNS name followed by colon and port number. Currently, the value of the webServer attribute is being picked up by the Eclipse Package Explorer Crossflow context menu during workflow deployment and execution (cf. Section 5.1) and may require adaptation, e.g. localhost:80 (or: localhost), for deployment on the Crossflow Docker image web server instance (cf. Section 6.3).

```
<experiment

title="GitHub Technology Popularity Analysis"

class="org.eclipse.scava.crossflow.examples.technologyanalysis.TechnologyAnalysis"

jar="org.eclipse.scava.crossflow.examples.technologyanalysis.jar"

input="in"

output="out"

summary="GitHub Technology Popularity Analysis Workflow."

webServer="localhost:8080"

>
</experiment>

Figure 20: Running example workflow XML-based experiment configuration.

Deployment. Workflows can be deployed within the Crossflow web application by browsing to the “Upload New Workflow” page accessible through a button located on the main page. The
upload page displays a form requiring the input of an experiment name, an assembled workflow archive, and (optionally) the selection of a checkbox for immediate execution of the specified workflow (cf. Figure 21). More specifically, the experiment name acts as unique internal identifier within the context of the Crossflow master node and any worker nodes contributing to the same master node. The assembled workflow archive is represented by the ZIP archive file generated by the use of the Crossflow context menu and in particular the selection of “Generate Deployment Artifacts” (cf. Section 2.2). Clicking the “Upload” button on the upload page causes the specified workflow to be deployed and (optionally) executed—producing the equivalent result as achieved by selecting “Deploy Artifacts” or “Deploy Artifacts and Run (new browser window)” from the Crossflow context menu in the Eclipse Package Explorer view in case the “Launch experiment immediately” checkbox is checked. Further, the same artifacts generated in the “Generate Deployment Artifacts” step can be applied as deployment artifacts for worker nodes. Alternatively, to decrease storage, e.g. by excluding workflow input files only required for master nodes, a customized JAR may be assembled by right-click on the project name and selecting “Export…”, then “JAR file” and following the “JAR Export” wizard.

![Workflow upload form in Crossflow web application.](image)

**Figure 21: Workflow upload form in Crossflow web application.**

**Dependencies.** Currently, referenced sources and dependencies in Crossflow workflow implementations are made available to the web server running the Crossflow web application by packaging and supplying dependencies as JAR files to the web server’s `lib` folder. In detail, Eclipse workspace projects depicted in the Eclipse Package Explorer view can be packaged into JAR files by right-click on the project name and selecting “Export…”, then “JAR file” and
following the “JAR Export” wizard. In particular, in the running example, the following three projects have been packaged and exported as JAR files into the Apache Tomcat library directory:

- org.eclipse.scava.crossflow.restmule.core
- org.eclipse.scava.crossflow.restmule.dependencies
- org.eclipse.scava.crossflow.restmule.client.github

**Advanced Tab.** The experiment page of a workflow provides three build-in tabs. The “Advanced” tab (cf. Figure 22) shows an overview of the experiment as well as a checkbox to enable/disable automatic refresh of information displayed throughout several tabs on the experiment page. Moreover, the current status of the broker, i.e. either “stopped” or “running”, to which the Crossflow master node is connected to is displayed. Further, the occurrence of a previous execution as well as cached data of the experiment is displayed. Also, the path in the file system of the master node where experiments and their data is located is displayed by “Serving from”.

![Figure 22: Running example workflow experiment page “Advanced” tab in Crossflow web application.](image-url)
Execution. Workflows available to the Crossflow web application can be launched either automatically or manually. In the former case, either “Deploy Artifacts and Run (new browser window)” is selected from the Crossflow context menu or the “Launch experiment immediately” checkbox is checked during the deployment phase, respectively. In the latter case, the workflow is launched by browsing to the workflow’s dedicated experiment page within the Crossflow web application followed by a click on the “Start” button.

Log Tab. The log tab on the experiment page (cf. Figure 23) displays log messages produced during the execution of a workflow and in particular instances of CrossflowLogger that is accessible to classes extending org.eclipse.scava.crossflow.runtime.Workflow, such as TechnologyAnalysis in the running example, by passing severity level, i.e. info, warning, or error, and message to the log method.

Monitoring. The model tab on the experiment page (cf. Figure 24) visualizes the runtime model representation that has been auto-generated from its runtime workflow model during code generation (cf. Section 2.2). Web browser instances pointing to the experiment page of a workflow subscribe to a set of ActiveMQ topics that are maintained by the Crossflow runtime and broadcast the state of experiment execution through messages parsed into visual updates to the runtime model.
The status of a task is reported by its color. The color lightcyan, skyblue, palegreen, salmon, and slategray indicate that a task has been started, is waiting, in progress, blocked, or finished, respectively (cf. Table 1). Further, if a task is colored white, no status has been reported.

<table>
<thead>
<tr>
<th>Color</th>
<th>Semantics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lightcyan</td>
<td>Started</td>
</tr>
<tr>
<td>Skyblue</td>
<td>Waiting</td>
</tr>
<tr>
<td>Palegreen</td>
<td>In Progress</td>
</tr>
<tr>
<td>Salmon</td>
<td>Blocked</td>
</tr>
<tr>
<td>Slategray</td>
<td>Finished</td>
</tr>
<tr>
<td>White</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Table 1: Task status color semantics as reported on workflow experiment page "Model" tab in Crossflow web application.

The total number of messages residing in a queue is reported by the number displayed inside the visible shape of a queue. Hovering over a particular queue shape displays a tooltip with detailed information about the status of a queue (cf. Figure 25). Each queue is made up of three instances.
of ActiveMQ queues that are referred to as Pre, Dest, and Post in Crossflow. Tasks connect to Post instances of queues. Subs indicates the number of subscribers. More details are described in D5.6.

**Workflow-Specific Tabs.** The running example owns two workflow-specific tabs—Input and Output. These tabs are the result of a Source and Sink instance defined in the workflow model, respectively. Figure 26 depicts the manifestation of the running example’s input in the Crossflow web application (cf. “Input” tab). More specifically, the TechnologySource task submits instances of Technology, i.e. consisting of file extension and MDE technology-specific keyword, to the Technologies queue. The “Output” tab (cf. Figure 27) represents the running example’s output in the Crossflow web application before experiment launch.

![Figure 26: Running example workflow experiment page “Input” tab in Crossflow web application.](image)
Management. The Crossflow web application provides several paths to manage deployed workflows from their experiment page. Clicking the “Stop” button (cf. Figure 28) triggers the submission of termination requests to worker nodes followed by a waiting period and termination of the master node. In case a workflow has been executed beforehand and is currently not being executed, a “Reset” button appears on the experiment page (cf. Figure 29). Resetting an experiment entails the removal of cached data as well as re-establishing its initial state, i.e. the state of initial deployment after completed workflow upload.

Figure 27: Running example workflow experiment page “Output” tab in Crossflow web application.

Figure 28: Running example workflow experiment page in Crossflow web application during workflow execution.
Moreover, the “Model” tab of a workflow’s experiment page offers the ability to clear the content of a particular queue and all queues of a workflow, respectively. In the former case, a particular queue is cleared by right-clicking the selected queue (cf. Figure 30) followed by left-clicking the option displayed by the appearing context menu and confirming the operation in the exposed pop-up window (cf. Figure 31). In the latter case, all queues are cleared by right-clicking on an empty spot in the runtime model visualization (cf. Figure 32) followed by left-clicking the option displayed by the appearing context menu and confirming the operation in the exposed pop-up window.
5.3 **CROSSFLOW WORKER EXECUTION (CLI)**

This subsection describes steps involved during worker execution by the use of the Crossflow Command Line Interface (CLI).

---

**Figure 31:** Running example workflow experiment page in Crossflow web application after halted workflow execution and before clearing individual cache confirmation.

**Figure 32:** Running example workflow experiment page in Crossflow web application after halted workflow execution and before clearing entire cache.
Execution. Workers can connect to Crossflow workflows by the use of the Crossflow Command Line Interface (CLI) and in particular by specifying command line parameters value such as the name of the workflow to which they want to contribute to (required). A list of possible parameter specifications, their semantics, and default values are provided in Table 2. A minimal example of executing a worker connecting to the running example is listed below:

```
$ java -jar org.eclipse.scava.crossflow.examples.techanalysis.jar -name TechAnalysisWorkflow -instance TechAnalysisWorkflow
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Semantics</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The name of the workflow</td>
<td></td>
</tr>
<tr>
<td>master</td>
<td>IP of the master</td>
<td>localhost</td>
</tr>
<tr>
<td>port</td>
<td>Port of the master</td>
<td>61616</td>
</tr>
<tr>
<td>stomp</td>
<td>Port to use for STOMP based messages</td>
<td>61613</td>
</tr>
<tr>
<td>ws</td>
<td>Port to use for WS based messages</td>
<td>61614</td>
</tr>
<tr>
<td>activeMqConfig</td>
<td>Location of ActiveMQ configuration file</td>
<td></td>
</tr>
<tr>
<td>instance</td>
<td>The instance of the master (to contribute to)</td>
<td>Master</td>
</tr>
<tr>
<td>mode</td>
<td>Must be master_bare, master or worker</td>
<td></td>
</tr>
<tr>
<td>createBroker</td>
<td>Whether this workflow creates a broker or not</td>
<td>true</td>
</tr>
<tr>
<td>Parallelization</td>
<td>The parallelization of the workflow (for non-singleton tasks), defaults to 1</td>
<td>1</td>
</tr>
<tr>
<td>cacheEnabled</td>
<td>Whether this workflow caches intermediary results of not</td>
<td>False</td>
</tr>
<tr>
<td>deleteCache</td>
<td>Before starting this workflow, delete the contents of the cache by queue name (use empty string to delete entire cache)</td>
<td>false</td>
</tr>
<tr>
<td>inputDirectory</td>
<td>The input directory of the workflow</td>
<td>in^6</td>
</tr>
<tr>
<td>outputDirectory</td>
<td>The output directory of the workflow</td>
<td>out^7</td>
</tr>
<tr>
<td>disableTermination</td>
<td>Flag to disable termination when queues are empty</td>
<td>True</td>
</tr>
</tbody>
</table>

Table 2: Crossflow CLI parameters, semantics, and default values.

^6 Relative to experiment/in from the root of the user workflow project.
^7 Relative to experiment/out from the root of the user workflow project.
6. INSTALLATION GUIDES

This section will provide installation guides for both the graphical and textual workflow editors as well as the deployment, monitoring, and execution-management web-application presented in this document. The guides assume that the user has installed the latest version of Eclipse (Photon) Modeling Tools distribution\(^8\) and has Java 8 installed on their machine.

6.1 CROSSFLOW GRAPHICAL EDITOR INSTALLATION AND LAUNCH

This subsection describes the installation and launch of the Crossflow graphical editor. The use of said editor for the creation of graphical workflow specifications is described in Section 3.2.

**Installation.** In order to setup the Crossflow graphical editor, the following software needs to be added to the Eclipse installation, using the “Install New Software” option in the “Help” menu:


The next step is to import the Crossflow graphical editor project from the SCAVA Crossminer repository\(^9\). After cloning this Git repository to the local machine, the projects can be imported into the Eclipse workspace by using the “File > Import > Git > Projects from Git > Existing local repository”. After selecting the local clone, use “Import existing Eclipse projects” and then in the next page select the following projects to be imported, before clicking “Finish”:

- org.eclipse.scava.crossflow.language(.*)

**Launch.** Once these tools and projects are installed, running a new Eclipse instance from the “Run” menu, selecting “Run Configurations” and creating a new “Eclipse Application” will enable the editor.

In this new Eclipse instance, first create a new Plug-in Project and then a new graphical Crossflow model by right-clicking on the created project and selecting “File > New > Other > Crossflow Diagram”. This will create a new file with the extension .crossflow_diagram in the Crossflow Diagram Editing editor ready to be populated with elements of the Crossflow language.

6.2 CROSSFLOW TEXTUAL EDITOR INSTALLATION AND LAUNCH

This subsection describes the installation and launch of the Crossflow textual editor. The use of said editor for the creation of textual workflow specifications is described in Section 4.2.

**Installation.** The Crossflow textual editor is installed as follows. First, make sure required Xtext Eclipse plugins are installed; to install Xtext in Eclipse, (i) select “Help > Install New Software”, (ii) add the Xtext update site\(^10\), (iii) select the Eclipse plugin named “Xtext Redistributable”, (iv) click the “Next >” button, and (v) follow the instructions to finalize the plugin installation.

\(^8\) [https://www.eclipse.org/downloads/eclipse-packages/](https://www.eclipse.org/downloads/eclipse-packages/)

\(^9\) [https://github.com/crossminer/scava/tree/crossflow/crossflow](https://github.com/crossminer/scava/tree/crossflow/crossflow)

Secondly, the Github repository [https://github.com/crossminer/scava/tree/crossflow/crossflow](https://github.com/crossminer/scava/tree/crossflow/crossflow) is cloned to a particular location on a user’s local machine. Third, the following set of projects are imported using the “Existing Projects into Workspace” wizard having selected “Search for nested projects”:

- org.eclipse.scava.crossflow.language(.*)
- org.eclipse.scava.crossflow.language.xtext(.*)

**Launch.** Once these tools and projects are installed, running a new Eclipse instance from the “Run” menu, selecting “Run Configurations” and creating a new “Eclipse Application” will enable the editor.

In this new Eclipse instance, first create a new Plug-in Project and then a new textual Crossflow model by right-clicking on the created project and selecting “File > New > Other > Crossflow Model” and confirming the conversion of the selected parent project to an Xtext if requested. This will create a new file with the extension .crossflow_model and display it in the Crossflow Editor ready to be populated with elements of the Crossflow language.

### 6.3 CROSSFLOW WEB APPLICATION INSTALLATION AND LAUNCH

**Installation.** The Crossflow web application is available as a Docker container image hosted on Docker Hub[11]. To deploy the said image, make sure the target machine has a running Docker installation and provides access to the Docker CLI either by an application such as Kitematic or the target machine operating system (native) console allowing to issue Docker commands. To install Docker on the target machine, follow the instructions provided by the official Docker documentation[12].

**Launch.** The Docker Crossflow web application container can be deployed from a Docker CLI-capable console by issuing the following command exposing several parameters, such as –p for port mappings between the target machine and the Docker container, allowing individual configurations[13]:

```bash
$ docker run -it --rm -d --name crossflow \
  -p 80:8080 \ 
  -p 61616:61616 \ 
  -p 61614:61614 \ 
  -p 5672:5672 \ 
  -p 61613:61613 \ 
  -p 1883:1883 \ 
  -p 8161:8161 \ 
  -p 1099:1099 \ 
  crossminer/crossflow:latest
```

Running the above command in a Docker CLI-capable console will first retrieve the Docker Crossflow web application, i.e. similarly to issuing the command docker pull


[12] The official Docker documentation provides details on how to install Docker on several different platforms and can be found online at [https://docs.docker.com](https://docs.docker.com).

[13] The semantics of Docker run parameters are described by the output produced by issuing the console command docker run --help
crossminer/Crossflow:latest, and then launch the obtained image with respect to the specified configuration parameters. In more detail, it follows the steps defined in the respective Dockerfile\(^{14}\) that includes (i) obtaining copies of Apache Tomcat and Apache ActiveMQ, (ii) configuring both Apache Tomcat and Apache ActiveMQ by copying predefined XML-based configuration files to their respective application configuration directories, (iii) copying the Crossflow web application archive file to the Apache Tomcat web application deployment directory, and (iv) launching both Apache ActiveMQ and Apache Tomcat. Finally, the Crossflow web application (cf. Figure 33) can be accessed by pointing a web browser instance to specified port of the target machine followed by /org.eclipse.scava.crossflow.web/ or, in case no changes have been made to the above Docker run command, to http://localhost/org.eclipse.scava.crossflow.web/.

\(^{14}\) The Crossflow web application Dockerfile is part of the org.eclipse.scava.crossflow.web.docker project and publicly available at https://raw.githubusercontent.com/crossminer/scava/crossflow/crossflow/org.eclipse.scava.crossflow.web.docker/Dockerfile

![Figure 33: Docker Crossflow web application start page.](image-url)
7. **CONCLUSION AND FUTURE WORK**

This document presented the progress within the Crossminer task associated with the implementation of tools supporting the workflow modeling process. Workflows allow for the definition of bespoke analysis algorithms in a high-level domain-specific language and require the creation of appropriate tools to create, manipulate, generate, monitor, and manage them and their execution. The reported progress in this regard includes the implementation of a graphical and textual editor supporting the modeling of Crossflow workflows as well as the implementation of a web browser-based application for the deployment, monitoring, and management of workflows.

Future work in this regard includes the adaptation of the Crossflow metamodel, and thus also both graphical as well as textual language, for the definition of additional concepts that may arise from unforeseen workflow specifications. Moreover, the development of transformations between the graphical language as well as the textual language may be provided to enable seamless editing of both textual as well as graphical models. Further, the packaging-step performed during the generation of executables for the deployment of Crossflow workflows will be extended to automate the packaging of referenced projects (cf. “Dependencies” paragraph in Section 5.1).

Tables on the final status of the user and technology requirements related to WP5 of the Crossminer project can be found below, containing the requirement name and description, its overall priority as well as its final status.
## TABLE ON FINAL STATUS OF USE-CASE PARTNER REQUIREMENTS FOR WP5

<table>
<thead>
<tr>
<th>ID</th>
<th>Description</th>
<th>Overall Priority</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>U122</td>
<td>Provides a mechanism to define a retrieval, cleaning and analysis process based on reusable components</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>U123</td>
<td>Provides a mechanism to play individual parts of the retrieval and analysis process</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>U124</td>
<td>Provides a mechanism to easily analyse new data sources and define new measures</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>U125</td>
<td>Able to use data from all existing data collectors</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>U126</td>
<td>Provides a mechanism to analyse and visualise data in an external tool (e.g. R, Tableau, .. Excel)</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>U127</td>
<td>Provides a library of reusable components</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>U128</td>
<td>Provides a list of available data sets when building a new workflow</td>
<td>SHOULD</td>
<td>Unsupported</td>
</tr>
<tr>
<td>U129</td>
<td>Provides R as a computing engine for analyses</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>U130</td>
<td>Able to identify if the developer is not using the most recent version of a library and provide notification</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>U131</td>
<td>Provides a means to execute a workflow across data sets</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>U132</td>
<td>Provides a means to execute a workflow across forges</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>U133</td>
<td>Able to support different execution priorities</td>
<td>MAY</td>
<td>Unsupported</td>
</tr>
<tr>
<td>U134</td>
<td>Allows compositions of Crossminer and external results to support decisions</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>U135</td>
<td>Able to define specific formatting for the results</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>U136</td>
<td>Able to process data sets from GitHub and StackOverflow</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
</tbody>
</table>
### TABLE ON FINAL STATUS OF TECHNOLOGY REQUIREMENTS FOR WP5

<table>
<thead>
<tr>
<th>ID</th>
<th>Description</th>
<th>Overall Priority</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>D47</td>
<td>The framework shall provide built-in support for network/API error recovery</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D48</td>
<td>The framework shall provide built-in support for data caching</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D49</td>
<td>The framework shall provide support for graphical editors for specifying knowledge extraction workflows</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D50</td>
<td>The framework shall provide a Java API for specifying knowledge extraction workflows</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D51</td>
<td>The graphical workflow editors should provide support for auto-completion, navigation and refactoring</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>D52</td>
<td>The framework shall provide parallel workflow execution capabilities</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D53</td>
<td>The framework shall provide distributed workflow execution capabilities</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D54</td>
<td>The framework shall provide debugging facilities</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D55</td>
<td>The framework shall provide workflow execution monitoring facilities</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D56</td>
<td>Workflow execution facilities shall be architecturally consistent with the platform so that workflows can be executed as metric providers</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D57</td>
<td>Connectors shall be implemented for the APIs of GitHub, StackOverflow and Bugzilla</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D58</td>
<td>Connectors should be implemented for GHTorrent, GitHub Archive and JIRA</td>
<td>SHOULD</td>
<td>Unsupported</td>
</tr>
<tr>
<td>D59</td>
<td>The platform shall expose a REST API that workflow components can consume</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
<tr>
<td>D60</td>
<td>The API of the platform should be formally specified</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>D61</td>
<td>Mining tools developed in WPs 2-4 and 6 should be embeddable as components in knowledge extraction workflows</td>
<td>SHOULD</td>
<td>Supported</td>
</tr>
<tr>
<td>D62</td>
<td>The platform shall provide facilities for running custom workflows and displaying the results in appropriate dashboards</td>
<td>SHALL</td>
<td>Supported</td>
</tr>
</tbody>
</table>
REFERENCES


APPENDIX A: CROSSFLOW GRAPHICAL MODELING LANGUAGE DEFINITION
(CROSSFLOW.EMF)

crossflow.emf

1 @gmf
2 @namespace(url="org.eclipse.scava.crossflow", prefix="cf")
3 package crossflow;
4
5 @gmf.diagram(onefile="true")
6 class Workflow {
7  attr String name;
8  attr String -package;
9  val Stream[*] streams;
10  val Task[*] tasks;
11  val Type[*] types;
12  val Field[*] parameters;
13  val Language[*] languages;
14 }
15
16 @gmf.node(figure="ellipse", label="name", label.icon="false")
17 abstract class Stream {
18  attr String name;
19 }
20
21 @gmf.link
22 ref Type type;
23
24 @gmf.link(target.decoration="filledclosedarrow")
25 ref Task[*]#input inputOf;
26
27 class Topic extends Stream {
28     ...
29 }
30
31 class Queue extends Stream {
32     ...
33 }
34
35 @gmf.node(label="name", label.icon="false")
36 class Task {
37     attr String name;
38     ref Stream[*]#inputOf input;
39     @gmf.link(target.decoration="filledclosedarrow")
40     ref Stream[*]#outputOf output;
41     @gmf.link(target.decoration="filledclosedarrow")
42     attr Boolean masterOnly = "false";
43     attr Boolean parallel;
44     attr Boolean cached;
45     attr Boolean multipleOutputs = "false";
46     ref Field[*] parameters;
47     ref Language[*] languages;
48     ref Type[*] configurations;
49 }
50
51 @gmf.node(label="name", label.icon="false", figure="polygon", polygon.x="0 10 11 10",polygon.y="0 2 4 4")
52 class Source extends Task {
53     ...
54 }
55
56 @gmf.node(label="name", label.icon="false", figure="polygon",polygon.x="0 10 10 5 0",polygon.y="0 4 6 4")
57 class CsvSource extends Source {
58     attr String fileName;
59 }
60
61 @gmf.node(label="name", label.icon="false", figure="polygon",polygon.x="0 10 10 5 0",polygon.y="0 4 6 4")
62
63
crossflow.emf

65 class Sink extends Task {
66 }
67
68 class CsvSink extends Sink {
69   attr String fileName;
70 }
71
72 @gmf.node(label="name")
73 class CommitmentTask extends Task {
74   attr int commitAfter = 1;
75 }
76
77 @gmf.node(label="name")
78 class OpinionatedTask extends Task {
79 }
80
81 @gmf.node(label="name", figure="rectangle")
82 class Type {
83   attr String name;
84   attr String impl;
85   attr boolean[1] isMany;
86 }
87
88 @gmf.link
89   ref Type[*] extending;
90
91 @gmf.compartment(layout="list",collapsible="false")
92 val Field[*] fields;
93
94 @gmf.node(label="name,type", figure="rectangle", label.pattern="(0):(1)", label.icon="false")
95 class Field {
96   attr String name;
97   attr String type = "String";
98   attr boolean many = false;
99 }
100
101 @gmf.node(label="name", figure="rectangle")
102 class Language {
103   attr String name;
104   attr String package;
105   attr String outputFolder;
106   attr String genOutputFolder;
107
108 @gmf.compartment(layout="list",collapsible="false")
109 val Parameter[*] parameters;
110 }
111
112 @gmf.node(label="name,value", figure="rectangle", label.pattern="(0):(1)", label.icon="false")
113 class Parameter {
114   attr String name;
115   attr String value;
116 }
APPENDIX B: CROSSFLOW TEXTUAL WORKFLOW MODELING LANGUAGE DEFINITION (CROSSFLOW.xtext)

Crossflow.xtext

1 /* *
2 Copyright (c) 2019 The University of York.
3 * This program and the accompanying materials
4 * are made available under the terms of the Eclipse Public License 2.0
5 * which is available at https://www.eclipse.org/legal/epl-2.0/
6 *
7 * Contributor(s):
8 * Patrick Neubauer - initial API and implementation
9 */
10
11 import "org.eclipse.scaava.crossflow.language.xtext.Crossflow with org.eclipse.xtext.common.Terminals"
12
14
15 Workflow returns Workflow:
16 (Workflow)
17 'Workflow'
18 name=EString
19 '('
20 ('package' package=EString)?
21 ('streams' (' streams++Stream (streams++Stream)* ')' )?
22 ('tasks' (' tasks++Task (tasks++Task)* ')' )?
23 ('types' (' types++Type (types++Type)* ')' )?
24 ('parameters' (' parameters++Field (parameters++Field)* ')' )?
25 ('languages' (' languages++Language (languages++Language)* ')' )?
26 ')
27 ');
28
29 Stream returns Stream:
30 'Stream'
31 topic | queue;
32
33 Task returns Task:
34 (Task)
35 'Task'
36 name=EString
37 '('
38 ('input' (' input++=[Stream]EString (input++=[Stream]EString)* ')' )?
39 ('output' (' output++=[Stream]EString (output++=[Stream]EString)* ')' )?
40 ('parameters' (' parameters++=[Field]EString (parameters++=[Field]EString)* ')' )?
41 ('languages' (' languages++=[Language]EString (languages++=[Language]EString)* ')' )?
42 ('configurations' (' configurations++=[Type]EString (configurations++=[Type]EString)* ')' )?
43 ')
44 ');
45
46 Type returns Type:
47 (Type)
48 'Type'
49 name=EString
50 '('
51 ('isMany' impl=EString)?
52 ('extends' (' extends++=[Type]EString (extends++=[Type]EString)* ')' )?
53 ('fields' (' fields++Field (fields++Field)* ')' )?
54 ')
55 ');
56
57 Field returns Field:
58 (Field)
59 ""
Crossflow.xtext

65 (\text{\texttt{?}}} ==\text{\texttt{many}})\
66 \text{\texttt{Field}}\
67 \text{\texttt{name}} = \text{\texttt{EString}}\
68 \text{\texttt{\{}}}\
69 \text{\texttt{\{}}}\
70 \text{\texttt{\{}}}\
71 \text{\texttt{\{}}}\
72 \text{\texttt{\{}}}\
73 \text{\texttt{\{}}}\
74 \text{\texttt{\{}}}\
75 \text{\texttt{\{}}}\
76 \text{\texttt{\{}}}\
77 \text{\texttt{\{}}}\
78 \text{\texttt{\{}}}\
79 \text{\texttt{\{}}}\
80 \text{\texttt{\{}}}\
81 \text{\texttt{\{}}}\
82 \text{\texttt{\{}}}\
83 \text{\texttt{\{}}}\
84 \text{\texttt{\{}}}\
85 \text{\texttt{\{}}}\
86 \text{\texttt{\{}}}\
87 \text{\texttt{\{}}}\
88 \text{\texttt{\{}}}\
89 \text{\texttt{\{}}}\
90 \text{\texttt{\{}}}\
91 \text{\texttt{\{}}}\
92 \text{\texttt{\{}}}\
93 \text{\texttt{\{}}}\
94 \text{\texttt{\{}}}\
95 \text{\texttt{\{}}}\
96 \text{\texttt{\{}}}\
97 \text{\texttt{\{}}}\
98 \text{\texttt{\{}}}\
99 \text{\texttt{\{}}}\
100 \text{\texttt{\{}}}\
101 \text{\texttt{\{}}}\
102 \text{\texttt{\{}}}\
103 \text{\texttt{\{}}}\
104 \text{\texttt{\{}}}\
105 \text{\texttt{\{}}}\
106 \text{\texttt{\{}}}\
107 \text{\texttt{\{}}}\
108 \text{\texttt{\{}}}\
109 \text{\texttt{\{}}}\
110 \text{\texttt{\{}}}\
111 \text{\texttt{\{}}}\
112 \text{\texttt{\{}}}\
113 \text{\texttt{\{}}}\
114 \text{\texttt{\{}}}\
115 \text{\texttt{\{}}}\
116 \text{\texttt{\{}}}\
117 \text{\texttt{\{}}}\
118 \text{\texttt{\{}}}\
119 \text{\texttt{\{}}}\
120 \text{\texttt{\{}}}\
121 \text{\texttt{\{}}}\
122 \text{\texttt{\{}}}\
123 \text{\texttt{\{}}}\
124 \text{\texttt{\{}}}\
125 \text{\texttt{\{}}}\
126 \text{\texttt{\{}}}\
127 \text{\texttt{\{}}}\
128 \text{\texttt{\{}}}
Crossflow.txt

129  name=EStr
130  {'fileName' 'fileName'=EStr}\n131  {'input' 'input'=[(Stream[EStr], input*=[Stream[EStr]])*]}?\n132  {'output' 'output'=[(Stream[EStr], output*=[Stream[EStr]])*]}?\n133  {'parameters' 'parameters'=[Field[EStr], parameters*=[Field[EStr]]}*]}?\n134  {'languages' 'languages'=[Language[EStr], languages*=[Language[EStr]]}*]}?\n135  {'configurations' 'configurations'=[Type[EStr], configurations*=[Type[EStr]]}*]}?\n136  '\}
137
138  Sink_Impl returns Sink:
139  (Sink)
140  (masterOnly?='masterOnly')?\n141  (parallel?='parallel')?\n142  (cached?'cached')?\n143  (multipleOutputs?='multipleOutputs')?\n144  'Sink'
145  name=EStr
146  {'input' 'input'=[(Stream[EStr], input*=[Stream[EStr]])*]}?\n147  {'output' 'output'=[(Stream[EStr], output*=[Stream[EStr]])*]}?\n148  {'parameters' 'parameters'=[Field[EStr], parameters*=[Field[EStr]]}*]}?\n149  {'languages' 'languages'=[Language[EStr], languages*=[Language[EStr]]}*]}?\n150  {'configurations' 'configurations'=[Type[EStr], configurations*=[Type[EStr]]}*]}?\n151  '\}
152
153  CsvSink returns CsvSink:
154  (CsvSink)
155  (masterOnly?='masterOnly')?\n156  (parallel?='parallel')?\n157  (cached?'cached')?\n158  (multipleOutputs?='multipleOutputs')?\n159  'CsvSink'
160  name=EStr
161  {'input' 'input'=[(Stream[EStr], input*=[Stream[EStr]])*]}?\n162  {'output' 'output'=[(Stream[EStr], output*=[Stream[EStr]])*]}?\n163  {'parameters' 'parameters'=[Field[EStr], parameters*=[Field[EStr]]}*]}?\n164  {'languages' 'languages'=[Language[EStr], languages*=[Language[EStr]]}*]}?\n165  {'configurations' 'configurations'=[Type[EStr], configurations*=[Type[EStr]]}*]}?\n166  '\}
167
168  CommitmentTask returns CommitmentTask:
169  (CommitmentTask)
170  (masterOnly?='masterOnly')?\n171  (parallel?='parallel')?\n172  (cached?'cached')?\n173  (multipleOutputs?='multipleOutputs')?\n174  'CommitmentTask'
175  name=EStr
176  {'input' 'input'=[(Stream[EStr], input*=[Stream[EStr]])*]}?\n177  {'output' 'output'=[(Stream[EStr], output*=[Stream[EStr]])*]}?\n178  {'parameters' 'parameters'=[Field[EStr], parameters*=[Field[EStr]]}*]}?\n179  {'languages' 'languages'=[Language[EStr], languages*=[Language[EStr]]}*]}?\n180  {'configurations' 'configurations'=[Type[EStr], configurations*=[Type[EStr]]}*]}?\n181  '\}
182
183  OpinionatedTask returns OpinionatedTask:
184  (OpinionatedTask)
185  (masterOnly?='masterOnly')?\n186  (parallel?='parallel')?
Crossflow.xtext

193 (cached?='cached')?
194 (multipleOutputs?'multipleOutputs')?
195 'OpinionatedTask'
196 name=EString
197 '{
198 ('input' 'input+=[Stream]String] (input+=[Stream]String] )*')?;
200 ('parameters' 'parameters+=[Field]String] (parameters+=[Field]String]*')?
201 ('languages 'languages+=[Language]String] (languages+=[Language]String]*')?
202 ('configurations 'configurations+=[Type]String] (configurations+=[Type]String]*')?
203 '}
204 EInt returns.ecore::EInt;
206 '=' INT;
207 EBoolean returns.ecore::EBoolean;
209 'true ' 'false';
210 Parameter returns Parameter;
212 (Parameter)
213 'Parameter'
214 name=EString
215 '{
216 ('value' value=EString)?
217 '}
218 ;